
   

 

 

A. Database Basic  

(You can Skip this section if you are not indented t o Learn Database) 

About Access databases 

This software is developed by Access Database 2003. 

A database is a collection of information that's related to a particular subject or purpose, such as tracking 

customer orders or maintaining a music collection. If your database isn't stored on a computer, or only parts of 

it are, you may be tracking information from a variety of sources that you're having to coordinate and organize 

yourself. 

For example, suppose the phone numbers of your suppliers are stored in various locations: in a card file 

containing supplier phone numbers, in product information files in a file cabinet, and in a spreadsheet 

containing order information. If a supplier's phone number changes, you might have to update that information 

in all three places. In a database, however, you only have to update that information in one place— the supplier's 

phone number is automatically updated wherever you use it in the database. 

 

About sharing an Access database on a network (MDB) 

Note The information in this topic applies only to a Microsoft Access database (.mdb). 

If your computer is connected to a network, you and others can work with one Microsoft Access database at the 

same time. 

Ways to share data 

There are several ways you can share data in a multi-user environment. 

Share the entire Access database You can put the entire Access database on a network server or in a shared 

folder. This is the easiest method to implement. Everyone shares the data and uses the same forms, reports, 

queries, macros, and modules. Use this strategy if you want everyone to use the Access database the same way 

or if you can't support users creating their own objects. 

Share only the tables in the Access database You can put only the tables on a network server, and keep other 

database objects on users' computers. In this case, the Access database's performance is faster because only data 

is sent across the network. When you split a database into a back end (tables) and a front end, users can 

customize forms, reports, and other objects in their front-end databases without affecting other users. 
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Share Access database objects or data access pages on the Internet You can output one or more database objects 

to static HTML or server-generated HTML format, or create data access pages, and then display them in a 

browser, such as Microsoft Internet Explorer, on the World Wide Web. 

Replicate the Access database    If you use two computers, such as an office computer and a portable computer, 

you can use Microsoft Windows Briefcase to make replicas of your Access database and keep those replicas 

synchronized. Also, several users at different locations can work on their own copies at the same time and then 

synchronize them over the network, either through a dial-up connection or on the Internet. 

Create a client/server application    if you work in a client/server environment, you can take advantage of the 

extra power and security it provides by creating a client/server application. You store your data in tables on a 

database server such as Microsoft SQL Server instead of in local tables in Microsoft Access. The Access 

application (the client) retrieves the data it needs from the server. The server maintains data integrity and runs 

any queries that it can evaluate. 

The locking information (.ldb) file 

When you open an Access database file (.mdb) in shared mode, Microsoft Access also creates a locking 

information file (.ldb) with the same file name (for example, Northwind.ldb) and in the same folder as the 

database file. This locking information file stores the computer name (such as mypc) and security name (such as 

Admin) of each shared user of the database. Microsoft Access uses this information to control concurrency. In 

most cases, Microsoft Access automatically deletes the locking information file when the last user closes the 

database file. 

Editing data in a shared database 

In a multi-user environment, more than one person might be working with the same records at the same time. 

Since other people can change or even delete the same data you're trying to edit, you might occasionally 

conflict with others as they work. 

Microsoft Access helps you keep track of the status of records as you edit them, and makes sure you're using 

the latest data. When two or more people try to edit the same record, Microsoft Access displays messages that 

help you resolve conflicts. For example, if you try to save a record that another user has locked, Microsoft 

Access displays the name of the person who locked that record. 

To help you keep track of the status of records, Microsoft Access displays the following symbols in the current 

record selector. 

Symbol Meaning 
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This record is the current record and hasn't been edited. 

 

You have edited this record, but you haven't saved your changes yet. As long as this symbol is 

displayed, other users can't see the changes you've made to the record, and they won't be able to edit the 

record, if you have the record locked. To free the record for use by others, either save or undo your 

changes. 

 

This record is locked by another user. You can't edit it. If you try to type in a locked record, Microsoft 

Access sounds a beep. 

 

You can also set options that control the locking of data and the refreshing of data in a shared database.  

Default record locking settings 

 No Locks    Microsoft Access does not lock the record you're editing. When you try to save changes to 

a record that another person has also changed, Microsoft Access displays a message giving you the 

options of overwriting the other user's changes to the record, copying your version of the record to the 

Clipboard, or discarding your changes. This strategy ensures that records can always be edited, but it 

can create editing conflicts between users.  

 Edited Records    Microsoft Access locks the record you're editing, so no other user can change it. It 

might also lock other records that are stored nearby on your disk. If another user tries to edit a record 

that you've locked, Microsoft Access displays the locked record indicator in the other user's 

datasheet. This strategy ensures that you can always finish making changes that you start. It is a good 

choice if you don't have editing conflicts often.  

 All Records    Microsoft Access locks all records in the form or datasheet (and underlying tables) 

you're editing for the entire time you have it open, so no one else can edit or lock the records. This 

strategy is very restrictive, so choose it only when you know you're the only person who needs to edit 

records at any one time.  

When you edit data in a linked SQL database table by using ODBC, Microsoft Access doesn't lock records; 

instead, the rules of that SQL database govern locking. In this instance, regardless of the record-locking setting 

you choose for your database, Microsoft Access always acts as though the No Locks setting has been selected. 

Page-level and record-level locking 

You can specify the granularity of locking that Access uses in a shared database. If you use page-level locking, 

Access locks the 4K page (the area of memory where the record is located), and editing a record might cause 
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other records stored nearby to be locked as well. However, performance is generally better when you use 

page-level locking. 

If you use record-level locking, Access locks only the record you are editing. This becomes the default behavior 

for access to data through a form, a datasheet, and code that uses a recordset object to loop through records, but 

not through action queries, nor through code that performs bulk operations using SQL statements. 

Update retries and refreshes interval settings 

You can use the Update Retry Interval and Number of Update Retries settings to specify how often and how 

many times Microsoft Access tries to save a record that is locked by another user. You can also use the ODBC 

Refresh Interval and Refresh Interval settings to control how often Access refreshes your data. Refreshing only 

updates data that already exists in your datasheet or form. It doesn't reorder records, display new records, or 

remove deleted records and records that no longer meet specified criteria. To view these changes, you must 

requery the underlying records for the datasheet or form. 

Saving design changes in a shared database 

You cannot save design changes to a Microsoft Access database while other users have the Access database 

open. The only way to ensure that changes are saved is by opening the Access database in exclusive mode. 

In general, when you try to make a design change to a database object (except tables and queries) or an item in 

shared mode, Access will temporarily promote you to exclusive mode for the Access database if you are the 

only user of the Access database at that time. When you save all your design changes and close all the Design 

view windows, Access returns the Access database to shared mode. In the interim, other users will not be able 

to open the Access database. 

If another user has the Access database open in shared mode and you try to make a major design change, such 

as modifying a form, Access alerts you that you might not be able to save your changes. However, if another 

user has the Access database open in shared mode and you try to make a minor design change, such as changing 

printer settings, Access doesn't alert you that you might not be able to save your design changes. In both cases, 

you might want to wait until you are the only user of the Access database so that you can save your major 

design changes and Access can save your minor design changes. 

A data access page is handled differently. Although creating, renaming, moving, and deleting a data access page 

still requires promotion to exclusive mode (because this requires changing information in the Access database), 

editing a data access page does not require promotion to exclusive mode (because the corresponding HTML file 

exists in the file system outside the database). 
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Differences between major and minor design changes 

If you don't have exclusive access to an Access database, Access will alert you when you might not be able to 

save the following major design changes: 

 Changes to database objects (except table and queries) made in Design view  

 Changes to a form property sheet in Form view  

 Compiling the project, modifying project properties, or adding or removing a reference in the Visual 

Basic Editor  

 Renaming, pasting, or deleting a database object  

 Saving a database object as another type of database object  

 Adding or modifying controls on a command bar  

 Editing custom groups in the Database window  

 Creating, renaming, moving, and deleting a data access page  

If you don't have exclusive access to an Access database, Access doesn't alert you when you might not be able 

to save the following minor design changes: 

 Changes to datasheet formatting properties, such as line styles and fonts  

 Freezing, unfreezing, hiding, and showing datasheet columns  

 Adjusting datasheet column width and row size  

 Changes to the filter or sort order for a form or datasheet  

 Changes to the state of a sub datasheet (whether expanded or collapsed)  

 Changes to the OLE/DDE link of an OLE object or changes to the contents of an unbound object frame  

 Changes to printer settings  

 Changes to a command bar, such as its location and whether or not it's visible  

 Changes to the layout of the Database window  

Strategies for sharing Access database design and development 

If you are going to share the design of an Access database, consider using the following strategies: 

 Assign specific objects or groups of objects to specific developers. For example, assign one developer 

to design forms and another to designs reports. Then, each developer can work on a private copy of the 

Access database. When your development team is ready for testing, assembly, and production, each 

developer can export the database objects from their private copy of the database to a main Access 

database.  
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 Use a source code control program. If you use Visual SourceSafe, it's a good idea to run the 

Performance Analyzer (on the Tools menu, point to Analyze, and then click Performance) on a regular 

basis to maintain optimum performance.  

Tips for saving design changes in a shared database 

 If another user has a table open or is viewing data in queries, forms, or reports based on the table, you 

can't make any changes to the table's design. Microsoft Access informs you that it is read-only.  

 If objects are dependent on one another, update all of them at the same time so that other users don't 

open inconsistent versions of the objects. For example, if you want to add fields to a form, make sure to 

add the fields to the underlying query before you update the form.  

 If you change a query that another user has open, that user must close and reopen the changed object to 

use the latest version. With Microsoft Visual Basic for Applications (VBA) modules, other users can't 

run the updated Function or Sub procedures until they close and reopen the Access database.  

 

Share a database (MDB) 

Note   The information in this topic applies only to a Microsoft Access database (.mdb). 

To access the shared Microsoft Access database from another computer, you must have one of following on the 

other computer: a local installation of Access, a network installation of Access (licensed on a per-user basis), or 

a run-time application.  

1. Set up a shared folder.  

For information about sharing folders, use the Microsoft Windows Help Index. If the shared folder is on 

a network server, you might need assistance from your network administrator. 

2. Copy the Microsoft Access database to the shared folder.  

3. Make sure the Access database is set to open in shared mode, which is the default setting.  

How? 

1. On the Tools menu, click Options.  

2. On the Advanced tab, under Default open mode, click Shared.  

Note Before you share the database, you should remove any personal information that may be stored in the file. 

See Remove personal information from an Access file or page for more information. 
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Share a database (MDB) 

Note The information in this topic applies only to a Microsoft Access database (.mdb). 

To access the shared Microsoft Access database from another computer, you must have one of following on the 

other computer: a local installation of Access, a network installation of Access (licensed on a per-user basis), or 

a run-time application.  

1. Set up a shared folder.  

For information about sharing folders, use the Microsoft Windows Help Index. If the shared folder is on 

a network server, you might need assistance from your network administrator. 

2. Copy the Microsoft Access database to the shared folder.  

3. Make sure the Access database is set to open in shared mode, which is the default setting.  

How? 

1. On the Tools menu, click Options.  

2. On the Advanced tab, under Default open mode, click Shared.  

Connect to a network drive 

1. On the Standard toolbar (toolbar: A bar with buttons and options that you use to carry out commands. To 

display a toolbar, click Customize on the Tools menu, and then click the Toolbars tab.), click Open 

.  

2. In the Open dialog box, click Tools, and then click Map Network Drive.  

3. In the Drive box, click the drive letter you want.  

4. In the Folder box, enter the path (path: The route that the operating system uses to locate a folder or file; 

for example, C:\House finances\March.doc.) Of the folder you want to connect to.  

Tip 

To automatically connect to this network drive each time you start Microsoft Windows, select the Reconnect at 

logon check box. 

Open an Access data file on a network by using a UNC address 
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You might want to open a Microsoft Access data file (Microsoft Access file: An Access database or Access 

project file. An Access database stores database objects and data in an .mdb file. A project file doesn't contain 

data and is used to connect to a Microsoft SQL Server database.) On a network share by using a UNC (universal 

naming convention (UNC): A naming convention for files that provides a machine-independent means of 

locating the file. Rather than specifying a drive letter and path, a UNC name uses the syntax 

\\server\share\path\filename.) Path, instead of using the drive letter of a mapped network drive in Microsoft 

Windows Explorer. A drive letter can vary from one computer to another or may not always be defined, 

whereas a UNC path is a reliable and consistent way for Access to locate the Access data file. 

1. On the File menu, click Open .  

2. In the File name box, type the UNC address for the network share you want, and then press ENTER.  

For example, type \\Computer1\Files to open an Access data file on the Files share of the Computer1 

server. 

3. In the folder list, locate and open the Access data file you want.  

Tip 

To open an Access data file on a network share you've recently opened by using a UNC address, click the arrow 

next to the File name box within the Open dialog box, and then click the UNC connection. 

About upsizing a Microsoft Access database 

Upsizing is the process of migrating some or all database objects from a Microsoft Access database (.mdb) to a 

new or existing Microsoft SQL Server database or new Microsoft Access project (.adp). 

Ways to upsize 

The Upsizing Wizard upsize an Access database to a new or existing SQL Server 2000, 7.0, and 6.5 databases 

or new Access project by migrating data and data definitions, and by moving database objects to the new 

database structure. There are three ways to use the Upsizing Wizard: 

 Upsize all database objects from an Access database to an Access project so that you can create a 

client/server application. This approach requires some additional application changes and modification 

to code and complex queries.  

 Upsize only data or data definitions from an Access database to an SQL Server database.  
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 Create an Access database front-end to an SQL Server database back-end so that you can create a 

front-end/back-end application. This approach requires very little application modification since the 

code is still using the Jet database engine.  

When to upsize an Access database to SQL Server 

Over time, most database applications grow, become more complex, and need to support more users. At some 

point in the life of your Access database application, consider upsizing to SQL Server to optimize database and 

application performance, scalability, availability, security, reliability, and recoverability. 

High performance and scalability 

In many situations, SQL Server offers better performance than an Access database. SQL Server also provides 

support for very large, terabyte-sized databases, which is much larger than the current limit for an Access 

database of two gigabytes. Finally, SQL Server works very efficiently on Microsoft Windows 2000 or later by 

processing queries in parallel (using multiple native threads within a single process to handle user requests) and 

minimizing additional memory requirements when more users are added. 

Increased availability 

SQL Server allows you to do a dynamic backup, either incremental or complete, of the database while it's in use. 

Consequently, you do not have to force users to exit the database to back up data. This means your database can 

be running up to 24 hours a day, seven days a week. 

Improved security 

Using a trusted connection, SQL Server can integrate with the Windows 2000 or later system security to 

provide a single access to the network and the database, employing the best of both security systems. This 

makes it much easier to administer complex security schemes. A SQL Server database on a server also employs 

innovative security features, which helps prevent unauthorized users from getting to the database file directly, 

but rather they must access the server first. 

Immediate recoverability 

In case of system failure (such as an operating system crash or power outage), SQL Server has an automatic 

recovery mechanism that recovers a database to the last state of consistency in a matter of minutes, with no 

database administrator intervention. Critical applications can be up and running again right away. 
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Server-based processing 

Microsoft designed SQL Server from the beginning as a client/server database, where data and indexes reside 

on a single server computer that is often accessed over the network by many client computers. SQL Server 

reduces network traffic by processing database queries on the server before sending results to the client. Thus, 

your client/server application can do processing where it's done best, on the server. 

Your application can also use user-defined functions, stored procedures, and triggers to centralize and share 

application logic, business rules and policies, complex queries, and data validation and referential integrity code 

on the server, rather than on the client. 

 

Security Warning (At Starting MerchanNet) 

About Microsoft Jet Expression Service sandbox mode 

Microsoft Office Access 2003 uses the Microsoft Jet Expression Service to evaluate expressions (expression: 

Any combination of mathematical or logical operators, constants, functions, and names of fields, controls, and 

properties that evaluates to a single value. Expressions can perform calculations, manipulate characters, or test 

data.). The Jet Expression Service can be configured to run in sandbox mode. Sandbox mode is a mode of 

operation where only safe expressions can be evaluated. 

About unsafe expressions 

Unsafe expressions contain functions that could be exploited by malicious users to access drives, files, or other 

resources for which they do not have authorization. If malicious users have access to these resources, then they 

may be able to perform actions such as deleting all of the files from a folder, tying up a network resource, or 

modifying a file. 

To make your Access databases (MDBs) and projects (ADPs) more resistant to malicious attacks, you should 

enable sandbox mode. Sandbox mode allows Access to be fully functional while blocking unsafe expressions. 
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Functions that are blocked in sandbox mode 

The following functions are blocked when the Jet Expression Service is configured to run in sandbox mode. 

The functions cannot be used in expressions, but they can be utilized in Visual Basic for Applications (VBA) 

code. 

Blocked functions located in the Visual Basic for Applications (VBA) object library 

Function Name 

 

AppActivate  

Beep  

Calendar  

CallByName  

ChDir  

ChDrive  

Command  

Command$ 

CreateObject  

CurDir  

CurDir$ 

DeleteSetting  

DoEvents 

Environ  

Environ$ 

EOF  

Err 

FileAttr 

FileCopy  

FileDateTime  

FileLen  

FreeFile  

GetAllSettings  
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GetAttr  

GetObject 

GetSetting 

Input 

Input$ 

InputB 

InputB$ 

Kill 

Load 

Loc 

LOF 

Randomize 

Reset 

SaveSetting 

Seek 

SendKeys 

SetAttr 

Shell 

Spc 

Tab 

Unload 

UserForms 

Width 

Blocked functions and properties in the Microsoft Access object library 

Object Blocked Function/Property 

Application AddAutoCorrect  

Application AddToFavorites  

Application ADOConnectString  

Application AnswerWizard  

Application Application  

Application Assistant  

Application AutoCorrect  
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Application BeginUndoable  

Application CloseCurrentDatabase  

Application CodeContextObject  

Application CodeDb  

Application COMAddIns  

Application CommandBars  

Application CompactRepair  

Application ConvertAccessProject  

Application CreateAccessProject  

Application CreateAdditionalData  

Application CreateControl  

Application CreateControlEx 

Application CreateDataAccessPage  

Application CreateForm  

Application CreateGroupLevel  

Application CreateNewWorkgroupFile  

Application CreateReport  

Application CreateReportControl  

Application CreateReportControlEx 

Application CurrentDb  

Application DataAccessPages  

Application DBEngine  

Application DDEExecute  

Application DDEInitiate  

Application DDEPoke  

Application DDERequest  

Application DDETerminate  

Application DDETerminateAll  

Application DefaultWebOptions  

Application DefaultWorkspaceClone  

Application DelAutoCorrect  

Application DeleteControl  

Application DeleteReportControl  

Application DoCmd  



   

 

 

Application Echo  

Application ExportXML  

Application FeatureInstall  

Application FileDialog  

Application FileSearch  

Application FollowHyperlink  

Application GetHiddenAttribute  

Application ImportXML  

Application InsertText  

Application LanguageSettings  

Application LoadFromText  

Application LoadPicture  

Application Modules  

Application NewAccessProject  

Application NewCurrentDatabase  

Application NewFileTaskPane  

Application OpenAccessProject  

Application OpenCurrentDatabase  

Application Parent  

Application ProductCode  

Application Quit  

Application References  

Application RefreshDatabaseWindow  

Application RefreshTitleBar  

Application ReloadAddIns  

Application ReplaceModule  

Application RunCommand  

Application SaveAsText  

Application SetDefaultWorkgroupFile  

Application SetHiddenAttribute  

Application SetOption  

Application SetUndoRecording  

Application SysCmd  

Application TransformXML  



   

 

 

Application VBE  

BoundObjectFrame  Object 

Combobox  Recordset 

Control Object 

CurrentProject  AccessConnection  

CurrentProject  BaseConnectionString  

CurrentProject  CloseConnection  

CurrentProject  Connection  

CurrentProject  OpenConnection  

CustomControl  Object 

Form Dynaset  

Form Recordset  

Form RecordsetClone 

Hyperlink  AddToFavorites  

Hyperlink  CreateNewDocument  

Hyperlink  Follow  

ListBox Recordset 

ObjectFrame Object 

Report Recordset 

SmartTagAction  Execute 

Screen ActiveDataAccessPage  

How to enable sandbox mode 

Follow these steps to enable sandbox mode: 

1. On the Tools menu, point to Macro, and then click Security.  

2. Click the Security Level tab, and then click Medium or High.  

3. Click OK.  

4. Restart Access. 

Note  Enabling the sandbox mode setting applies to all users of the computer. 



   

 

 

When are unsafe expressions blocked? 

These functions are blocked only when used in expressions such as for a default value, a control source, or in a 

SQL statement. These functions are not blocked for use in VBA code. 

How to use a blocked function in an expression 

You can utilize a blocked function in an expression by wrapping the function in a public VBA function. For 

example, you can create the following VBA function in order to use the blocked CurDir function: 

 

Public Function MyCurDir() As String 

 

    MyCurDir = CurDir() 

 

End Function 

You would call the MyCurDir() function in your expression instead of calling the CurDir() function. 

How to disable sandbox mode 

Follow these steps to disable sandbox mode: 

1. On the Tools menu, point to Macro, and then click Security.  

2. Click the Security Level tab, and then click Low.  

3. Click OK.  

4. Restart Access. 

Note  At this security level, macros are always enabled when you open files.  

Note Disabling the sandbox mode setting applies to all users of the computer. 

 

 



   

 

 

 

 

There are some issues from Microsoft Window OS when using this software. 

 

 

 

For Better Viewing and outlook of the control buttons. 

Please switch your Window Application to WindowXp (Modify) 

In the Control panel - Monitor - Theme - select WindowXp (Modify). 

Thus you will get the better view on the control button and interface. 

 

 

Window updates: 

We always recommend our user to upgrade their computer OS to the most updated version of services 

pack in order to get the 

Best viewing result, stability, security and driver for using MerchanNet. 

Window2000 - SP4 

Window2003 - SP2 

WindowNT   - SP6 

 

MerchanNet are no longer support Window98 and Window ME. If you need a version for these OS. 

Please contact us separately. 

We will tailor made one for you. 

 

 

 

A. Issues: 

 

1. Microsoft Database Jet engine. 

 

You may need the most updated Jet engine 4.0 to run our software. In order to avoid sandbox operation 

error. 

 

http://support.microsoft.com/?scid=kb;zh-tw;239114 

 

 

2. DAO Object Error 

 

A Visual Basic Data Access Object (DAO) application starts to fail with the following error message after 

Office 2000 SR-1 is installed:  



   

 

 

Run-time error '429': ActiveX component can't create object.    

 

http://support.microsoft.com/default.aspx?scid=kb;en-us;260885 

 

RESOLUTION 

Download the Microsoft Office 2000/Windows 2000 Registry Repair Utility. The Microsoft Office 

2000/Windows 2000 Registry Repair Utility restores the registry settings for several important files that 

prevent potential issues. 

 

http://download.microsoft.com/download/office2000pro/o9regfix/2000/win98/en-us/o9regfix.exe 

 

 

3. Active X Parameters 

 

Windows 2000 Security Patch: ActiveX Parameter Validation Vulnerability 

Microsoft has released a patch that eliminates a security vulnerability affecting customers using Microsoft 

Windows 2000. The vulnerability could allow enable a malicious user to potentially run code on another 

user’s machine. 

 

http://www.microsoft.com/Downloads/details.aspx?displaylang=en&FamilyID=19B2BF01-BA79-47D6-

9372-79A9FFF9663B 

 

 

4. Microsoft Data Access Components (MDAC) 2.8 

 

For some version of MS windows OS may not get the most updated MDAC. 

Microsoft Data Access Components (MDAC) 2.8 contains core Data Access components such as the 

Microsoft SQL Server? OLE DB provider and ODBC driver. Please download from here 

 

http://www.microsoft.com/downloads/details.aspx?FamilyID=6c050fe3-c795-4b7d-b037-185d0506396c

&DisplayLang=en 

 

 

5. OLE customs control. 

 

Some MS windows may not get the most updated OCX control. If you have error message regarding this. 

If you want to use an OLE custom control (OCX) in Microsoft Access, you need to install the 

dynamic-link library file Oc1016.dll on your computer and to register the file. The library file and its 

installation instructions are available in the Oc1016.exe file.  

 



   

 

 

The following file is available for download from the Microsoft Download Center: 

 

http://support.microsoft.com/default.aspx?scid=kb;en-us;128387 

 

 

6. COM/OLE Server Fails to Start on Windows NT 4.0 

 

When you try to start a (COM) Automation server or embed an OLE object, you may receive one of the 

following error messages: 

 

Microsoft Visual Basic:  

Run-time error '429': ActiveX component can't create object 

Run-time error '53': File not found  

Microsoft Visual C++:  

0x80070003: The system cannot find the path specified.  

Microsoft Visual FoxPro:  

DCOM error: %1 is not a valid Windows NT application  

Microsoft Office (OLE):  

Failed to create object. 

[Office App Name] can't start the application required to open this object.  

This problem only occurs on computers that are running Microsoft Windows NT 4.0.  

 

 

RESOLUTION 

Here are three resolutions: ‧ Reinstall the ActiveX server to a short folder path. For example, you can 

reinstall Microsoft Office to C:\Office97. To reinstall to a different path, you should first uninstall the 

application before reinstalling.  

 

-Or-  

‧ Uninstall any applications that are installed in the conflicting folder (for example, C:\Program), and 

then delete or rename this folder so that it no longer conflicts. After you rename or delete this folder, you 

might need to re-register or reinstall your ActiveX server application to ensure it is properly registered.  

 

-Or-  

‧ Edit the LocalServer32 key in the Registry for the ActiveX server application. The LocalServer32 key 

specifies the path to the ActiveX server. Change the path from a long path name to a short path name.   

 

http://support.microsoft.com/default.aspx?scid=kb;en-us;185126 

 

 



   

 

 

 

 

 

 

B.  Basic drivers’ requirement. 

 

If you have OLE server problem, OCX, ActiveX communication error. May be your computer is missing 

the following object library. 

Please check and see if it is missed in your operating system. 

 

 

1. MS Form 2.0 Object Library C:/Windows/System32/fm20.dll 

 

 

2. Snapshot Viewer Control C:/program files/common files/microsoft shared/snapshot 

viewer/snapview.ocx 

 

 

3. MS Window Common Control 6.0 (SP6) C/windows/system32/mscomctl.ocx 

 

 

4. MS Shell Control & Automation C:/windows/system32/shell32.dll 

 

 

5. MS Active X Data Object 2.5 Library C:/program files/common files/system/ADO/msado25.tlb 

 

 

6.MS DAO 3.6 Object Library C:/program files/common files/microsoft shared/DAO/dao360.dll 

 

 

7. OLE Automation C:/windows/system32/stdole2.tlb 

 

 

8. MS Access 11.0 Object Library C:/program files/microsoft office/office 11/msacc.olb 

 

 

9.  Visual Basic For Application C:/program files/common files/microsoft 

shared/VBA/VBA6/vbe6ext.olb 

 

 



   

 

 

10. MS Office Document Imaging 11.0 Type Library C:/program files/common files/microsoft 

shared/MODI/11.0/mdivwctl.dll 

 

 

 

 

C. Known Issue 

 

when importing photos some of the Microsoft Windows will have freeze progress bar on the screen. if 

you face this error. Please  

Close the application and reopen. It will clear the memory and close the progress bar. 

You may also turn off the import progress bar in the system registry. However, we only recommend 

advance user of MS windows to 

Perform this kind of hot fix. 

 


